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Introduction

Figure 1: GUI Startup Screen

In these exercises we introduce the use of the electronic oscilloscope. The oscilloscope is an electronic eyeball

that can display electronic signals, that is, it can show the way a time-varying voltage changes over time.

Startup

Ensure that the instrument hardware is plugged into a USB port on your computer. The green LED on the hardware

should illuminate.

Start the software by double clicking on the icon on the the computer screen desktop. The software should

start and show the GUI (Graphical User Interface). The connection indicator at the top of the GUI should show

’Connected’ with a green background, as shown in figure 1.

Transient Signal

In this first exercise, we show how to catch a single, fast event on the oscilloscope.

Connect a BNC-Binding post adaptor to the Channel A input of the scope. Attach alligator clip leads to the

binding posts1.

On Channel A, set the amplitude to 5V per division by clicking on its minus sign.

1Other connection methods are possible: the BNC to alligator clip lead, for example.



On channel B, left click on the Options button and click on Disable, so that only Channel A is being

displayed.

Left click on the green trigger cursor and drag it vertically one division, approximately 5 volts. When the

oscilloscope detects the Channel A signal pass through this level, it will begin recording the signal.

Left click on the purple X cursor and drag it to the left one division. The X cursor establishes the horizontal

position on the display where the trigger event is displayed.

Under Trigger Mode, select Single Shot. Left click on Single-Shot Reset.

Now, when the input signal on Channel A exceeds the trigger level, the oscilloscope will capture and display

the voltage just before and just after that event. Connect the Channel A clip leads to a 9 volt battery (or the leads

from a 9 volt power supply). The Red terminal of the binding post adaptor should connect to positive of the

battery, the Black terminal to negative. When you touch the clip lead to the battery terminal, the scope should

capture the event of the connection, as shown in figure 2.

Figure 2: Transient Capture

In the example of figure 2 there was first a brief connection, where the voltage jumps from zero to ten volts

0.2 milliseconds. Then, approximately 2 milliseconds later, there was a more permanent connection, followed by

1 millisecond of noise. After that, the connection becomes more reliable and the voltage stays around 10.2 volts.

Notice that the oscilloscope has captured events that are far too rapid for human senses. This is at the relatively

slow timebase setting of 1 millisecond per division. This oscilloscope timebase can be as fast as 50 nanoseconds

per division.

If you’d like to do a new capture, click on Single Shot Reset and make the connection again.

Exercise

1. Capture a similar transient signal on your equipment setup. Make a screen capture of that result and include it

with your results from this laboratory.

2. Based on the waveform that you capture, describe the behaviour of the connection. Is in clean or noisy?
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Displaying a Repetitive Signal

Many electronic signals repeat in a predictable fashion. In this section, we explore how to display such a signal.

We’ll use the CircuitGear signal generator to produce a suitable signal. We assume that you are familiar with

the signal generator section of the instrument. If not, we recommend first doing the lab exercise on the signal

generator.

(a) Clip Lead Connection (b) BNC Cable Connection

Figure 3: Connecting Generator to Scope

Connect the output of the signal generator to the Channel A input of the oscilloscope.

There are various ways to accomplish this. In figure 3(a), the generator output and the Channel A oscilloscope

input are connected to adaptors that bring out the BNC connector on the hardware to two binding posts. You can

then use alligator clip leads to connect between the binding posts: red to red, black to black.

Figure 3(b) shows the output of the generator connected to the Channel A input of the scope by a BNC to

BNC cable.

Figure 4: Display of Sine Wave

Move the generator Amplitude control to about to a setting of 70 and you should see a display resembling

figure 4.

Voltage is vertical, time is horizontal. The trace on the screen is a plot of voltage versus time.

The Basic Display

The display is capable of showing two traces, but we will only use one trace at this time. On Channel B, left

click the Options button and select Disable. This leaves the oscilloscope displaying the data for Channel A.

Now examine the screen. Notice that the display area is divided into squares. This is known as the graticule.

There are ten major divisions horizontal and vertical on the screen.
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Each major division is further subdivided by 5 tic marks. The red value on Channel A is currently set to 1V,

which is interpreted as one volt per division. Centre of the screen is zero volts. With the trace centred vertically,

the range of the display is from +5 volts to -5 volts. In this case, the displayed waveform goes from+2.5 to -2.5

volts, or 5 volts peak-peak.

Exercise

Set the waveform generator control to maximum (100). What is the amplitude of the sine wave in volts, peak-

peak?

Result:

It is sometimes convenient to move the trace vertically on the display screen. For example, you might want to

place trace A in the upper half of the screen, with trace B in the lower half. At the right side of the screen, find the

red A and drag it vertically. Notice that the zero value for a trace travels with that trace.

Cursors

Select the menu item View -> Toggle Channel A Cursors.

Two horizontal cursors appear in the display area. They are red, the same colour as the Channel A trace. Drag

the cursor VA2 to the bottom of the waveform. Drag the cursor VA1 to the top of the waveform. An on-screen

readout shows the voltage between the two cursors.

Exercise

Check that the waveform amplitude is set to 70, then use the Channel A cursors to measure the peak-peak voltage

of the waveform.

Result:

Deselect the Channel A Cursors.

Select the menu item View -> Toggle Time Cursors. Two vertical cursors appear in the display area.

Drag the cursors so that the distance between them corresponds to one complete cycle of the waveform. For

example, place T1 at the point where the waveform crosses through zero, and T2 at a similar zero crossing

one cycle later. The on-screen readout gives you the time of one complete cycle (the waveform period) and the

reciprocal value (the waveform frequency). Compare the screen readout to the Frequency setting of the waveform

generator.

Result:

Measurements Window

The scope is capable of making measurements automatically. This is especially useful when making many mea-

surements, but it makes mistakes on complex waveforms. It’s a good idea to do a quick sanity check on the

values.

To open the Measurements Window, select View -> Auto Measurements

The example of figure 5 shows the measurements for Channel A. (Channel B is not being used so those values

are meaningless.)
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Figure 5: Measurements Window

Exercise

Change the settings of the waveform generator: Amplitude to 50 and frequency to 1000 Hz. Adjust the Channel

A vertical scale and timebase setting to show a few complete cycles of the waveform.

Use the graticule division values and/or the cursors to measure the first 6 values in the Auto Measurements

table. Compare the values obtained with the values shown in the Auto Measurements table.

Manual Measurment Auto Measurment

Frequency

Period

Average

Maximum

Minimum

Peak-Peak

RMS Measurement (Advanced Topic)

The Auto Measurement of RMS value requires that the time cursors be enabled and placed so that they define one

complete cycle of the waveform. Then the software computes the value of the waveform based on the original

definition of RMS: square the values in the waveform, find the mean value over one cycle, and take the square

root. Consequently, the RMS value should be correct regardless of the shape of the waveform.

Exercise

Display on the oscilloscope screen a few cycles of a sine wave at generator amplitude 50 and frequency 1000 Hz.

Enable the time cursors and drag them so they define the beginning and end of one cycle.

Enable the Auto Measurements window.

Compare the peak value of the waveform with the RMS value. Is this correct?

Explain:

Move the time cursors so that they now define one half of the sine wave cycle. What is the effect on the RMS

value?

Explain:
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Noise Variance (Advanced Topic)

Select the generator Noise waveform. Set the amplitude to 50. Set the Timebase to 1mSec. Enable the time

cursors. Enable the Auto Measurements panel.

(a) Set the time cursors so that they are 8 graticule divisions appart. Note the RMS value. It changes constantly.

Try to identify the maximum and minimum values.

(b) Now set the time cursors so that they are one-half a graticule divison appart. Again, note the minimum and

maximum values.

Why is there a difference between these two readings, and why does the longer time span of measurement

reduce the variance of the readings?

Explain:

Exploring the Trigger Controls

If you look closely at the sine wave you will see that it is being drawn repeatedly. However, each trace redraw

overlaps the previous trace, so the waveform appears to be steady.

Notice that the trigger indicator at the bottom of the screen says Triggered.

Change the Trigger Mode control to External. To do this, left click on the down arrow, then left click on

the External entry in the list. This setting means that the starting of the waveform display depends on some

external event.

To generate a new trace, click on Manual Trigger. Do this several times, noting the horizontal position

of the waveform each time. Each new waveform appears at a different point on the screen. This is because our

clicking on the Manual Trigger button is not synchronized with the waveform itself.

Change the Trigger Mode back to Auto. The display synchronizes again.

Trigger Point

Trigger Level

Figure 6: Display of Sine Wave

The trigger signal is generated when the waveform crosses through the level set by the green T trigger hori-

zontal cursor. The trigger point horizontally is determined by the X purple vertical cursor.

Left-click and drag the green trigger cursor upwards to about 1 volt. Notice how the waveform shifts, keeping

the trigger point coincident with the vertical X cursor.

Now drag the trigger cursor until it’s above the waveform. Notice that the waveform is now unsynchro-

nized, appears in a different location with each rewrite. Also the indicator at the bottom of the screen says Not

Triggered.

Drag the trigger cursor back down to zero volts. Now drag the vertical X cursor horizontally, left and right.

The waveform moves horizontally with the cursor. With the X cursor at the extreme left of the screen, the entire

display shows the waveform after the trigger event. With the With the X cursor at the extreme right the entire
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display shows the waveform before the trigger event. (One of the advantages of a digital oscilloscope like this one

is the capability of displaying a waveform before the trigger. That’s not possible in an analog oscilloscope.)

At the bottom of the screen, you can see the Triggered indicator flickering.

Now click on arrows next to the the Trigger Slope widget. Change Plus to Minus. The waveform

appears to flip upside down, but the waveform did not actually change: the scope is now triggering on a downslope

rather than an upslope, and the display of the waveform has changed.

Capturing Waveform Data to a Spreadsheet

Figure 7: Waveform Data in Spreadsheet

It can be useful for documentation and further analysis of the data to capture the waveform data to a spread-

sheet.

Here’s an example.

Display a stable waveform, such as a sine wave, on the oscilloscope screen.

Click on Tools -> Data Recorder.

Left click on the button Choose Export Directory. Choose a suitable directory for the storage of the

data.

Click on Start Logging.The Log Count will increment.

Click on Stop Logging. Move to the Export Directory you chose earlier. You should see a file with a

name like Jun-16-2014-16-32-17.csv. This is a file you can read with any text editor, or load into a

spreadsheet.

Figure 7 shows sine wave data loaded into a Libre Office spreadsheet, with a chart display of the data.

Exercise

Adjust the waveform generator to produce a signal of your choice. Adjust the oscilloscope to show a stable display

of this waveform. Capture the waveform to a .csv file, as described above.

Start the spreadsheet of your choice and load the .csv file into it. Use the graph or chart option of the

spreadsheet to generate a plot of the waveform. Compare the waveform shown on the oscilloscope with the one

produced in the spreadsheet. Explain any differences.
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Undersampling

A digital oscilloscope has many advantages over its historic predecessor, the analog oscilloscope (see page 10).

However, there is one artifact to be aware of: undersampling.

Consider the screen shot of figure 8(a).

(a) Undersampling 1 (b) Undersampling 2

Figure 8: Undersampling

Notice the generator frequency setting: 119016.8 Hz. Now look at the time cursors on the oscilloscope display:

1.8 Hz. Obviously something is incredibly wrong.

This is an example of undersampling, also commonly called aliasing. The oscilloscope is taking samples of

the incoming waveform. However, the sampling rate is such that it is subsampling the original waveform. We say

that the displayed waveform is downsampled by a factor of 66,000 or so. In this particular case, the sample rate

is approximately the same frequency as the signal, so the samples occur on successive cycles of the signal, each

time at a slightly different location.

Figure 9: An illustration of undersampling.The original waveform is the solid line. The sampling points are

the small circles. Notice that each sample is taken slightly later on the original waveform. The reconstructed

waveform is the dashed line, at a much lower frequency. The shape is preserved, so the reconstructed waveform

is also a triangular shape.

In terms of communications theory, the original signal is being multiplied by the sampling signal. The fre-

quency of the signal that is displayed on the screen is the difference between the frequencies of the input and the

sampling signals. In this case the two signals are different by 1.8 Hz.

It turns out that this phenomenon has a useful application: equivalent time sampling. The idea is to mix a high

frequency input signal with a similar frequency sampling signal to produce a display at a much lower frequency.

However, it’s tricky to use in practice and so Syscomp oscilloscopes don’t rely on that feature.

The phenomenon of subsampling can be prevented by ensuring that there are at least two samples - and

preferably more - per cycle of the input waveform. You can do that by increasing the speed of the timebase

(smaller values of time per division). In practice, it’s actually quite tricky to get a stable display like figure 8(a).

(Notice that I had to set the maximum and minimum frequencies of the Frequency slider.) You’re much more

likely to get something like figure 8(b), which is obviously not useful.
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Exercise

See if you can provide another example of subsampling.

Set the scope to 20mSec per division. Use different frequency values from figure 8(a)) for the generator

setting.

You’ll need to set the minimum frequency to 2800000. Then *very* slowly sweep the frequency slider. When

you see a clear waveform, try stepping the frequency by clicking in the frequency slider trough above or below

the slider. You may have to adjust the maximum and minimum frequency to zero in on the exact frequency you

need.

When you obtain a clear, downsampled waveform, attach a screenshot to your lab results.
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Appendix 1: Analog and Digital Oscilloscopes

Figure 10: Tektronix 7104 Analog Oscilloscope

Photo credit: http://www.barrytech.com/

tektronix/tek7000/tek7104.html

Historically, oscilloscopes were analog devices. The

Channel A and Channel B signals were conditioned in

sophisticated amplifiers, and then displayed on a CRT

(cathode ray tube). The beam of the CRT was swept

from left to right on the screen by an analog timebase cir-

cuit. A phosphor coating on the inside of the CRT made

the trace persist long enough to be visible to a human

observer. Analog oscilloscopes still exist, mostly as sur-

plus equipment. They are still the ultimate in waveform

fidelity. However, an analog scope is larger, heavier and

more expensive than the equivalent digital scope. The

CRT and it’s power supply, and the number of mechani-

cal switches, preclude miniaturization.

A digital oscilloscope has much simpler circuitry.

The input signals are converted to a stream of digital

numbers and stored in a memory chip in the hardware.

Then the host computer uploads the data from that mem-

ory and displays it on the screen.

The digital scope automatically comes with wave-

form storage, so it can display a single-shot event and

store it indefinitely. That’s very difficult and expensive

to do in an analog scope. A digital scope can show the

trace before the trigger event, another feat that is difficult to do with an analog scope. With a digital display, it’s

possible to have readout cursors, storage of the waveform data, spectrum analysis and many other features. Digital

scopes have very few mechanical switches, so they tend to be more reliable than analog scopes.

The digital scope does have some limitations: because it’s a sampling device, it’s subject to undersampling.

See page 8 for an exploration of that topic. The vertical resolution is limited in a digital scope, typically to one

part in 2
8. And the maximum sensitivity, for small signals, is limited by the internal noise of the digital circuitry.

This requires very careful design work to overcome.
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